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e 8 Fotx (KHZ) & Fotx (HZ) 28 Fotx (MHZ) =4 (=G/=E) (HV)
IBM, 640 x 350 31.469 70.086 25.175 +-
IBM, 720 x 400 31.469 70.087 28.322 -+
MAC, 640 x 480 35.000 66.667 30.240 -
MAC, 832 x 624 49.726 74.551 57.284 o
MAC, 1152 x 870 68.681 75.062 100.000 -
VESA, 640 x 480 31.469 59.940 25.175 -
VESA, 640 x 480 37.861 72.809 31.500 -
VESA, 640 x 480 37.500 75.000 31.500 -
VESA, 800 x 600 35.156 56.250 36.000 ++
VESA, 800 x 600 37.879 60.317 40.000 ++
VESA, 800 x 600 48.077 72.188 50.000 ++
VESA, 800 x 600 46.875 75.000 49.500 ++
VESA, 1024 x 768 48.363 60.004 65.000 -
VESA, 1024 x 768 56.476 70.069 75.000 -
VESA, 1024 x 768 60.023 75.029 78.750 ++
VESA, 1152 x 864 67.500 75.000 108.000 ++
VESA, 1280 x 800 49.702 59.810 83.500 -+
VESA, 1280 x 800 62.934 74.934 106.500 -+
VESA, 1280 x 960 60.000 60.000 108.000 ++
VESA, 1280 x 1024 63.981 60.020 108.000 ++
VESA, 1280 x 1024 79.976 75.025 135.000 ++
VESA, 1440 x 900 55.935 59.887 106.500 -+
VESA, 1440 x 900 70.635 74.984 136.750 -+
VESA, 1680 x 1050 65.290 59.954 146.250 -+
TYFOt
ot HO| AZ0|M 5 BNHX| 7t2M SOl Lineg FAISH: O| A2|= AlZhE +=8F 7|2t 6t 0|9 J4+=E =EF =2t gL Ch the
= kHzZ LIEF LT
FEFob
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35 HEF ECto|H X
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C 20| MX|2 CDE CD-ROM EZ10| 20| €2 M Q.
"Windows Driver"E O A Z SEI5IN Q.

0|= 0| MX| e 3tHOo| X|A|AFES [MEN L.
ot ME 22 S 22 S50 HESHA Q.

1.
2.
3.
4.

o1 SAMEUNG monitor installer

Select the morsorwhich you want o install

o | CANCEL |

5 HEcHo|YEot ot MY BIe ot C| AZ2|0f HOfE 20l LIEfLH=X| 2HOIgtL T XM et ‘2= Windows 2 MK 2ME &=
St 2.

A 31| 3-5



3-6 USB TO SERIAL E2}0|H A%

& MH PCO| 2XI5tA 2.

1. EZ2I0|H HX|& CDE CD-ROM E20|E0| oM Q.

2. "USB-SERIAL Driver"E O A Z 2 2/6IM| Q.

3. NextE Z=/stM|Q.

E E__ T —— T T B [ |
PL-2303 Driver Installer Program 7-L|

Welcome to the InstallS hield Wizard for PL-2303
US5B-to-Serial

The InzstallShield ‘wizard will install PL-2303 USE -to-Serial
on your computer. To continue, click Mext,

< Back

Cancel

4. Finish&

muju
n

1SN 2.

a - s T T - e
PL-2303 Driver Installer Program —[

InstallShield Wizard Complete

The InstallShield “Wizard has successfully installed PL-2303
USB-toSerial. Click Finish to exit the wizard

Cancel

< Back
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4 ATEQ|0| MX|

4-1 PColP

On Screen Display (OSD)
On Screen Display(OSD) 2Z GUI= ZHX|E 74 2EfOf| A PColP MM 0| RIS E|X| S U AFEXHO| A HEA|E LICH

OSD+= Connect 3tHE E¢| SAE T

>t
=2
re
N
Ot
rir
11
v
mju
=
Ok
mot

LTt Connect 2t H2 A|Zte I AFERIO|H| EA|E LIC.

Connect 3}MHO0f|A| Options &0f| M A = Q& L|C}

Options &2 Connect 3tEH0f| A Options H{ES =2f WM 2 = AFLCEL ZE S HEsIH W 2[R} Y27t DL T

Connect $}H

Connect &t 2 2t2|H AR = A5 HZZ ZEO| TG E 25 MAStL AR U 2AIELCH
#e| 2 QIEmo|A0|AM WA O|0|XK|E YR ESHH <Connect> HE 2|0 EAIE 21 E HAY = YASLICH

2l 2-1: OSD Connect ™

Options

i
TERADICI

AZEQ| 0 K|



Connect HE

Connect H{E2 MEHSHH MM M0 2t PColP fE= RDP M[410] A|ZHE L|CL PColP HZ0| 27 521 S2tof= 0SD 2Z GUI|

“Connection Pending” | A|X| 7} EA|E L|CH HZ0| ™| OSD 2Z GUIZE AFEX| T A|M O|0|X| 2 CHA| &l L|C.

12| 2-2: OSD Connect 3}3H(1Z %)

P
TERADICI

Cancel

Contacting 152.168.1.100, pleass wait. ..

OSD <Options> M|+
<Options> | & HE4SHH ME4ALS ZZ0| LIEFEL|C. OSD <Options> M| 72| 742 L=t 25 Lt
+ <Configuration>

+ <Diagnostics>

* <Information>

* <User Settings>
+ <Password>

MEHARSE == BIL}

[S | o

mujr

HESHH 278 EO| LIEHELICY.

[ |

AZE Y EX|



12l 2-3: OSD <Options> 0|+

Configuration
Diagnostics
Informition
User Sattings
Fasswiord

o
TERADICI

Connect

<Configuration> %
<Configuration> A0 A= TE 317 ©& 9 X WS Folohs MHO| Iehel & S0 Za|Xp7 ANAE & USLICE
<Configuration> &2 F4st= B2 CtSot Z& L T}
*  <Network>
+ <Label>
« <Connection Management>
« <Discovery>
+ <Session>
« <RDP>
+ <lLanguage>
+ <0SD>
¢ <Reset>
*  <VMware View>

ZH o= 22lRot el B E dEE S L FaY 5 AU <OK>, <Cancel>, <Apply> H{E0| A& LICt

S PColP FX|= %= B2t H|gdot|of lon], 22| & T O|X|0f| 21215t LE OSD D71 4=0ff M| Agh I Y7t Hadt
7(l ?JQ L|C}. Log In IO X| 8! H 3 = PColP Management ConsoleOf| A| ZHMstst 4= 9l &L L},

<Network> EH

<Network> S0 A 22IX17} S YEY OP¥4+S BB + g

Network O 7 == 2 HO|X| 22| AHI 0| A5 ALESIO] Y == AS L CH

AmEY0f HX| 41



12l 2-4: <Network> 714

Metwork | Lot | Connction Managamant | Discovery [Session [ROP [Lengusge [050 [Reset [wmawars wiew

Changa the network settings for the davica

Enable DHCP:  |&

IP Addriss: 192, 188, 46 L1121
Subnet Mask: .0
Gateway: 192 1
Primiary DNS Server: 192, 163, z
Secondary DNS Server: 192,163 .1 | 80
Dioemizin Mame:
FADH:  |pcolp-pontal- 101 558a01 384
Ethermet Mods: Eo ‘]
[ ok [ cConcel | Apply
<Enable DHCP>

<Enable DHCP>7} ZHS}E|, IP x4, MELY OpA S, HO|EQ|0| IP F4, DNS MHE & Ea DHCP AfH{0f &X| 7}
YEELC) vl get SEfOIM = FX[0A Of2{0t D7 BiE =522 - oF YL CH

<IP Address>
IP Address & E = % X| 9| <IP address>Q| L|Ct. DHCP7} H|2HMd3t=l AL0|= 0| HEJF
O EE WY 4 YBLICH 0] L SHIE IP F20/0} 810, HRE IP 528 Y23}

e[ RFof| A LEFELICY.

<Subnet Mask>
<Subnet Mask> HE= FX|O A2 OtA3 QILIC. DHCP7t H|ZH g2tz Z20)= 0

| 24
oS WY 4 QoL 0l BEE SHE HEH DASC0 80|, ZRE M=y DHASE LS O/ +3s2tE 0SD

YL|C} DHCPZ} 2-g ot | H
0| 83lzt= OSD HA[X|7}

B AIX| 7} 22| XtOf| A| LHEFEF LI EL

<Gateway>

<Gateway> &l

T o K9] A0|£910| IP FAYLICE DHCP} blgh4etel 2201 0f D7t BAelL|ch DHCP7} g4 ske]
ol™WEZ Mt

- O
4 gL

Sl

<Primary DNS Server>

<Primary DNS Server> ZE = % X|0] 7|2 DNS IP FAQIL|C} O| 2HE= SMQUL|CL. DHCPI & d3str|H o) ES HElSH &~
FA=1= =

<Secondary DNS Server>

<Secondary DNS Server> ZE= A X|9| X DNS IP F=AQIL|C}H O] 2E= SMQL|CH DHCPZt & d3tz|H o) ZEE
HET = glgLCh

<Domain Name>
<Domain Name>2 'domain.local’ 1f Zt0| At2=l =09 O|EQL|Ct O] ZHEE= SMUL|CL. o EHE
Zoels X|ggtL ot

[m
FA
rir
Hel
um
=)
il
™

A

rir

<FQDN>

<FQDN>2 SAE L= T EO| M| =02l 0] Z(Fully Qualified Domain Name) | L|Ct. 7| £%t2 pcoip-host-MAC ==
pcoip-portal-MACO|H, MAC2 S A E = TEO| MAC F=AQLICE =091 0|£0]| 9 2™ pcoip-host-MAC.domain.local
#4202 0|50| F7HgLCE

<Ethernet Mode>
<Ethernet Mode> ZE = L EHO| Ethernet TES L MTILICEH M Ch2 1 25 L CH

2TEQY0f 4K a1



<Auto>
<10 Mbps Full-Duplex>
<100 Mbps Full-Duplex>

A°|X|9f 42 CHE | EQ 3 &H|E <10 Mbps Full-Duplex> EE= <100 Mbps Full-Duplex>0| M 2SSt E 2HE|0 Qe
42, 22| X t= g4k <Ethernet Mode>E <Auto> 2 A3 11 <10 Mbps Full-Duplex> EE= <100 Mbps Full-Duplex>2t A&
SH{OF SfL|Ct.

<Label> E4

<Label> B{OJ A= TE|K}7} BAE &

L IEA YEE FI1 = AT

r|r

Portal Label O§ 7} #14== 24 0| X] 2+2| OIE{TO|AS A

0_5
_O'_I-
2
-
0x
el
+

= AU

T2l 2-5: <Label> 7+

|Nm|mw|cmmmm|msmm|mm|m|w|osn|m|m~.mm

Configura the davice ientification

PCOIP Davice Noms: | IR |
PCOIP Device Description: |

Generic Tag: | |

<PColP Device Name>
<PColP Device Name> 0| A= 2 E|X7} SAE E= TEHO| =2|X 0|28 X|PE 4= USLICE 7|22 peoip-host-MAC EE= pcoip-
portal-MACO|0, MAC2 SAE E= ZEHO|IMAC FAQL|CEH

<PColP Device Description>

<PColP Device Description> 0fj A{= RE|X}7} 2 AE = ZEHO| A=ZEQIE X9 22 HFO|Lt XtAst HEE X|8e &= A& H
Ct.

<Generic Tag>

<Generic Tag>0f| A= 2|7} SAE £ ZEO| Generic Ef1 YEE X|HE &= JSLICH

<Connection Management> EH

<Connection Management> 2 At&SIH HZ T2 2ot Lt Bl date = on], HE 22| x| IP FAE X[FE += AUS
L|Ct. 2t2|™ HZA A, 25 <Connection Managerment> A{H{ K| } AlBHO] AHK % SlAoZ HOstD A $E 9,{§|_| Ch o
|

= XX
- O
Z BRI YAIS AZS WS OIS RO ABS AT SE

oA Z2|Xte] FFE A E0] FLIC

Connection Management O 7} == & I O|X| Zt2| OIE|{L|0| A S AFEEI0 F T =2 USL|CH

2TEQY0f 4K a1



12l 2-6: <Connection Management> 14

Network [ Lebed | Connection Management |Discoveny [Session [ROP [Lengusge 05D [Reset [itwere view

Corfigure the devica for a managed connection

Enable Connection Management: [
Identfy Connection Manager by:  * |P Addrass FQDN
Connaction Manager IP Address:
Enablg Event Log Motfication:
Enabls Diagnestic Log: O

<Enable Connection Management> SM0| 2Hdstc|H Q|2 A A2 X2 MK E TSI M og &= Q&L
+ <lIdentify Connection Manager By>
<ldentify Connection Manager By>ME{ 7| E ALSIH A 22| XIS <IP address>2 Al S 71Ol X| FQDN(FuIIy Qualified Domain
Name)OE AlRHSE ZHOIX| 22| X7t MEHS o~ QU& LIt Connection ManagementZ} H| 2t 5t 42, 0| 2 E &= T-7} OfL|H HE
g+ glsuch
E e HA

B212 & ¥ 3 0LIS MHHS [ A8 4+ % T4 D H+S BOIFLICH ZRE P F4 EE DNS 0128 YoHR 0/F
812t OSD HA|XI7} 22|X40) 4| LIErLICE

g Hoje 2=
<IP address> oA 2|KFHP A
<FQDN> o1z 2| X} DNS 0|2

+ <Enable Event Log Notification>
<Enable Event Log Notification> @ E+= PColP SAE Sl ;L& ZX| 7} X4 O|HIE 29| LI82 4 22| MHE 2 Z42IX| X O
gLch

+ <Enable Diagnostic Log>
<Enable Diagnostic Log> ZE = A2 22| ML C|H 1 HA|X| BE|XE PColP SAE Gl TH XX|9| O|HIE 20| 7|2 HQIX|
A ofghLCt.

<Discovery> £

The <Discovery> 7 B0 A= PColP A|AERI0M LES &H Aot = 7[5S A8 E =+ ASLICH

Discovery i 7} 4= 2 T0| x| 22| QIEIH|0|A S ALB3I0] TAE +& YLTt

AmEY0f HX| 41



113! 2-7: <Discovery> 1

batwork. | Label | Connection Manageman | Discovery | Session |RDF [Language | 050 | Reses [ vidwars view |

Automaticaly discover other PColP devices.

+ <Enable Discovery>
<Enable Discovery>g & 2d=lotH, HIEXT &2 YX[ 2IX|0f et A X| 4| 10|k, FX|7t SLP DiscoveryE AEH0] 1[0] &
|8 SH o= WALICL 0|5 Sof SEB AILHOM 74 U SRV =S 37 FY 4+ YLk

B SLP Discovery0f= HE|F|AES S| 2SI 2 Ll 21 R2E 7 EHRstE 2, M AM X2 = DNS-SRV Discovery
olL|Ct.
=]

+ <Enable Host Discovery>
<Enable Host Discovery> 7| 52 AF238}H PColP M0 9= SAEZS HO|A 274g 4= &L CH
0| 7| 50| &M3r|H, THYM LA =MINZE 712 SAEE 107§7HK| EA™ 4= JAS LT <Enable Host Discovery> 7|52 S A
E 7t H2 W Arg5HA LIt

<Session> EH

B Session Oj7Ez== 2 T O|X| 22| QIEEH O|AE AR S}

12l 2-8: <Session> 14

[ networts [ Labei | Gonnection Management | Discovery | S&ssion |ROP [Language | 05D | Reset [yvware view

Configurs the connection to @ paer devica

Sesshon Type:  FPColF =
KMy Piar by:  * 1P Addreds FQDM
Poer IP Address: 192 . 1621 . 100
Pear MALC Address: 00 =00 =00 00 =00 -0
Enabla Auto-Reconnact:

L e

» <Session Type>

<Session Type> 0| M= 2t2|X}7} PColP A4 &= RDP A|40] CHs ZEES e 5= ASLCh

<Identify Peer By>

<Identify Peer By> ME{T|E At23S}H IO ZHX|E IP & MAC A2 A% Z{91X| FQDN(Fully Qualified Domain Name)2 2 Al st

AZEY 0 X 4-1



HOIX| BRRT M & QgL
E225 5 98 3 6ILIS M2 1 ALSE 4 9l Tof ID Ujf ¥4 2OiFLICL HRE IP F4 £ DNS 0|52 228 of
S +sf2Hs OSD DI AIX|7} 22| X40| | LEEHELICH

m[o] ID Y HolE 2= 29
Peer IP Address PColP tE= & RDP 220|¢ E
Peer IP/MAC
Peer MAC Address PColP
Peer FQDN Peer FQDN PColP == L2 RDP Z2}0|

<Enable Auto-Reconnect>
<Enable Auto-Reconnect> SM S AF23IH MMO| ZRE|AS [, O[O 2 HASI SAEQN ZLEHO| AH5O 2 CHA| HAT 4= &
L|C}.

<Language> &
<Language> ZEOj| A= 22| Xt7} OSD §101E #de = AE LT

Language O§7lf ei== @ W|O[X| 22| AH M O[AE MESHH Y & USLICE

112! 2-9: <Language> T+°d

[ Matwork: [Latt [Connaction Mensgement [ Discovery [Session [RoP | Lenowaos | 050 [Reset v view |
Sedect 8 language for the user nterface
Lenguege: |Englsh |-
Keyboard Layout:  |USA 150-8859-1 Iz
[ ok || cencel |  appy
<Language>

<Language> ZE 0| A= OSD U AL X} O[HE 21 BA|X[2] §H0IE T4 = AELICH
<Keyboard Layout>

<Keyboard Layout> ZEO|A= 22| X7t 7| EE HIE S HAS 4= Q& L|CH

<Reset> EH

<Reset> EH0f A= ZH2| X7} SejAlof MEE 2N 7HSSH YA BSE BF ARE & AsLCH

Reset2 @ H|O|X| 22| QIE|HO|AE AFESIY =7|2tE o=k UFLIC.

12! 2-10: <Reset>

LZEQ 0 2% 4-1



| Metwort | Labet | Zonnection Management [Biscavery |session |[RDP [Language | 650 | Rezst |uware view

Reset all configuration and permissions settings: stored on the davice

Reset Parametars:

<Reset Parameters>

The <Reset Parameters> <Reset> HHE S AF25H R E M4 9 5|8 70| =10 A 2t

<VMware View> Ef

<VMware View> EH0| Al = VMware View Connection ServerE At235IEE LT 4= Q&L CH
g =2 JAEH T

2

@ VMware View Oj7§ ¥ == 2 | 0| X| 22| QIE{H| 0| A& A T

2l 2-11: <VMware View> 714

Metwiork | Lasted | Connection Managenmant | Discovery |smum|RDP |Law|030|m Vidware \“-&»'l_

= VMware View

Configura the View Connaction Server (RDP only) Sattings for the device
Ty ieriidobis Wik Fsburds, e “Eridbb Conriclion Mansgerent” chackbox under “Cormbction Mardgeman™

tab must be unchacked
Enabla Vidwara View: [
Idurtify Connaction Server by: = P Addrgss FQDM
Connection Server (P Address: L . .
Fort: (Drefaut is 50)
8L Usa securi connaction (S3L)
Ayto connect: Alwvays conmect to this sarver at startup

Lok [ Concal | Aoy

<Enable VMware View>

M

<Enable VMware View> &M S}H VMware View Connection ServerE At23tE

o
= ME5

B VMware View 7|52 243 sholat MEHS #| A3
Of gfLCt.

}&F2{™ <Connection Management> & 2| <Enable Connection Management>

<ldentify Connection Server by>
<ldentify Connection Server by> ME{7|E ALE S
Q C

=13

o= AWy oK Balx7t Me 4 9l

M A2 22| XIE IP address2 A3t 74 01 X| FQDN(Fully Qualified Domain Name)
VMware View?} b 2H21El 32, 0| BE& T47}otL|D B 4 gLt

_ =

4-1
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<Port>

<Port> O 7] ¥ 4=0{ M= 22| X}7F VMware View Connection Server?l EASH=0 ARSI ZEE X

<SSL>

<SSL> 0§ 7 =0 M= 2| Xt7F VMware View Connection Server@} EA15 SLLE K| ™H& 4= Q& L|CH

<Auto connect>

<Auto connect> O 7 H4=0f| A= 22| X7 ZEES A|ZHE [Iff VMware View Connection Server0Of| &4 At 0 2 G ASIEE X|He 4=
UAEL|C
<Diagnostics> &
<Diagnostics> &0 A= 22| X7t ZEH S TICHot= & Hof| AN AT 4= AUEL|CE <Diagnostics> &2 T#45t= B2 CtSat Z& LI
+ <Event Log>
+ <Session Statistics>
* <PColP Processor>
+ <Ping>
2t ’oll= 2 e Close HE0| /&L|CH
<Event Log> EH
<Event Log> B0 A= 2| X7t ZEHO|M O|HIE 21 HAIX|E B X|2 5= A& LICH
<Event Log>&= & Tf|O|X| &2| QA HH[O|AE AHBSI0] 27|t == AUSL|CH
2l 2-12: <Event Log>
Evant Log | Session Statistics | PGolR Frocessor [Fina |
WView avent log messages
011341339065 normal reboaps T on (epzen?
Od, O1:34:52. 906> Flirmware Version: 0.18
0d, 01134252, 906> Flrmware Bulld 10: vioz
i, 01134252, 906 Flirmware Bulld date: wow 22 RM? 23 alio2
O, 01334152, 906> PCOIP essor DDz Owll0d, revisdion: 0.0
O, 01134555, 455> NeTwork adaprer Inmel(R) PROJLO0O PL MeTwork Conmection (Microsoft’s
Packet sc.hcﬂu &r)
O, 012 . 531> BOOT-up ©
o, 1 L 33 uMque Idlﬁl.11"|¢r‘ Oi=15-B7- 5 -8 -4 -C ] Ere -2
od, 012 - 531> HDA 15 enabled
i, G112 . SA6> POSTY cﬂnrm PHY TEST PASSED
o, 01 . $6> POST: HD Awdio Test PASSED
0d, 0L . S46> POST: self-Test PASSED
i, 01 ¢ 19335 Network 1ink rate: 100 wmbiess, duplex: FuLL
0, 013 - 953> Eequest) DHCP e
N.Iﬂ. 455> EThernet (Lan) Adlﬂl:ll'.?ﬁ L168.0.142, 00-15-87-5C-B3-647)
O, O . TA5% ONS based discover
O, L2 . TES> Ready TO CONREST hast
<View event log message>
<View event log messages> E E0j|= EtAA R I FHOF 34 21 HA|X|Z7F EA|ELCE 7| M & 7t HHES A8 E =
A& L
* <Refresh>
<Refresh> HHE 2 MEHSIH HEA|=l O|HIE 21 HA|X|7} M2 DM ZIL|CL
+ <Clear>
<Clear> H{E2 ME5}01 HA|E| O[HIE 21 HAX|7} 25 X|YELICt
AmEY0f HX| 41



<Session Statistics> EH

<Session Statistics> EH0| A= +2|Xt7} ZEO|AM OpX|2to 2 2515 EH PColP A|AM2| PColP H& E|

<Session Statistics>= 2 L|0|X| 22| QA L|O|AE AFESHY & == USLICH

AZE Y EX|



12! 2-13: <Session Statistics>

Diagnostics

Evant Log | Session Statistics |PGelP Processor [Ping|

Vigw statistics from the last session

PColP Packets Sent: 123454323
PColF Packets Recelved: 123454321
PColP Packets Lost: 123454321
Bytes Sent: 40000000565
Bytes Received: 400000000869

Reound Trip Latency:

<PColP Packets Statistics>

<PColP Packets Sent>

<PColP Packets Sent> Z E = O}X|2t 2t M MO|A, ZEHOM SAEZ W = PColP IjZl &5 2 FL|C}.
<PColP Packets Received>

<PColP Packets Received> Z E = OFX|2F 2 MMO|A, SAEQA ZEZ BF2 = PColP I 7] &£ E o &L|C}
<PColP Packets Lost>

<PColP Packets Lost> Z == OX|2 2 MMO|A &A%l = PColP {7 & E0|EFL|CL

<Bytes Statistics>
<Bytes Sent>
<Bytes Sent > ZE = OfX| 2 2 M MO M 2 = HIO|E =2 HOFL|C

<Bytes Received>
<Bytes Received> EE = OtX|2 2 M MOfA 22 & HIO|E =& B0 FL{Ct

<Round Trip Latency>

<Round Trip Latency> ZE.= & 2tE PColP A|AEI(0]: ZEHO|AM SAEZ, CHA| ZEHE)0F | EYA X|FS 2| X Th|(+- 1ms)2
BoFLLCHL

<PColP Processor> Ef
<PColP Processor> 0| A= 22| X} 7} OFX| 8t HE| 0| ZE PColP T2 M AMQ| 7I5 A|ZHE 2 %= Q&L|CL

<PColP Processor> 7}z A| 72 & 0| X| 22| QIEH O] AN ME & 4= ASL|CE

ATZTEQ O MK 4-1



12! 2-14: <PColP Processor>

|Eva¢l Log ISesshn Statistics | FColP Processor |Bing

Wiew the time Since boot

Uptime 0 Days 1 Hours 58 Minutes 36 Seconds

<Ping> &4

<Ping> 0l A{= ZH2|Xt7F FX[0 E HAES HAISH0], IP L EQ T T ZE2E 4= A=K IS L|CE Ol SAE0| =2

Q=T Holst 1 983 4 UBLICEH

&l 2-15: <Ping>

Evant Log | Session Statistics | PColP Frocessor | Fing

Determing if a host ks reachabla across the network

Ping Settings

+ <Destination>
I HAEE MANZIP F=A £= FQDN
* <Interval>
I 2 Afolo] 72+
+ <Packet Size>
B EAETE D]
Packets
+ <8Sent>
EREE
<Received>

o 1IOlT A
EE=R T T EARE

LZES O] HX|

4-1



<Information> %

<Information> &0 A= Zt2| X}7} ZHK| Of 2t M E 7} I SHE| Version EHO|| QM| A

B Version Y2 &= & 4 O|X| &2| AHLOAE Sl 2 =& JUSLICH

712l 2-16: <Version>

Infermation
Version

‘Wienw the hardware and finmwarne version information

MAC Agdress: 00-15-87-90-63-64
Uniqus Identifier:  00-15-87-9C-83-64-chamt-2
Serkal Mumbaer:
Firmware Parl Number: PW010003
Hardware Wersion:

Firmware Version: 0.20
Firmwara Build ID: w120
Firmwara Build Date:  Mar 20 2008 18:40:40

PColP Procassor Revision, 0.0

Eocticader Version: 0.0
Bootloadar Build ID:
Eootloader Bulld Date:

VPD Information

VPD(Vital Product Data)= 2t L& fE= SAEES Q1A Al 4= QIE 2 Z71A| Of

+ <MAC Address>
185t L E <MAC address>

+ <Unique Identifier>
123t ZEHID

+ <Serial Number>

NestxE AH HS

» <Firmware Part Number>
PColP Hg|0je| & B}

* <Hardware Version>
ZESEQO HE S
Firmware Information
<Firmware Information> £ X} PColP &Y 0] MEAIES BtESEL|CL.

+ <Firmware Version>
Fxj PColP 0] B

» <Firmware Build ID>
S{X| PColP HYojo| 7| H R E

» <Firmware Build Date>
Il PColP Heojo] HE IRt

<PColP Processor Revision>

ZE=PColP ZZMAM 7HE T EE H0]FL|Ct TERA1x00 Revision A MZ|22 0.02 2 HA|L|O, TERA1X00 Revision B A 2| 22
1.09 2 HEA|EL|C}.
Bootloader Information
Bootloader Information2 $1Xlj PColP £ E 22| M| EAIES BrHTtL|CL.
* <Bootloader Version>
S{X| PColP HEEZHO| HH
AZE0f 45 4-1



* <Bootloader Build ID>
SiXf PColP EEZEHO| 7| A E

* <Bootloader Build Date>
SiXf PColP EEZ Ol HE IRt

<User Settings> &t

<User Settings> &0 A= Op2A Gl

u
T
In

A1 PColP O|0|X| 2& & X|Hs}

rir

g of AN A S gLch
User Settings 0|7 5 +&%t= 2 L2t 25U

*<Mouse>

«<Keyboard>

«<Image>

<Mouse> EH

<Mouse> H0f A= OSD 5! RDP M|M2| Ot A M £ HYS HEY & ASLICH

= AN
Local Keyboard Host Driver 7| 5 & AF235HX| %+ ¢, PColP MM 0| 2H3HE|0] /S [ OSD O A HA £ A™H 2 OFRA
FIM AA0| &S O|X|X| &L l_| CF (XFAMISH L2 PColP ZAE AZEQ 0] ALE APME HXRSHUAIR).

2! 2-17: <Mouse>

User Settings

Mouse | Keyboard |Image |

Adjust the mouse cursor spead

Show
Mouse speed:

<Mouse Speed>
<Mouse Speed> BEO|M= 28 Ot A AM £E5 7Y = ASLICH

<Mouse Speed> = PColP SAE AT EQ|0

£ E8f T4E 5 YLLICL PCOIP SAE 2T EQ0f AFRO| T3 XfASH
L{22 PColP SAE AT EY0f AL HHAE

<Keyboard> &
<Keyboard> £0j A{= OSD 5! RDP A|M2| 7| E g A S HAY 4= US|

Local Keyboard Host Driver 7|52 AF23}X| &= 3 PColP A|AM0] ZASHE|0f QIS [ 7| RE MAML J|RE MH0| Yt
KIX| & LT (RRMISH 82 PCO|P SAE AZEQO AL HYME BZIMIAIR.).

njo
=

2TEQY0f 4K a1



12l 2-18: <Keyboard>

User Settings
Mouse | Feyboard |Irnage|

Adjust the keyboard character repeat settings

Long Short
Keyboard Repeat Delay:

Show Fast
Keyboard Repeat Rate:

Repeat Settings Test Box: | |

[ ok |[ cencel | Apply

+ <Keyboard Repeat Delay >

<Keyboard Repeat Delay> ZEOAM = 28 7|HE HHE X|AHS A48 = JAELICL
» <Keyboard Repeat Rate>

<Keyboard Repeat Rate> ZEOfA= L E 7| HE B2 £ 2 15t 4= QI&L|C}
* <Repeat Settings Test Box >

<Repeat Settings Test Box> L =0 M= MEHSHI|EE AHES HAES 4= USL|CH

<Image>

<Image> 0 M= PColP A|AE10| O0|X| MHS #ZS 4 UBLCt
Image Of7{H === @ T O|X| &t2| QT O|AE AFBSH0] e == AFLICH
12! 2-19: <Image>

User Settings

Mouse | Keyboard |Image

Adjust the image settings (the maximum values may be limited by your
administrator)

Perception-Frae

Reduc:
Minimum Image Quality: —.
L]

¢ <Minimum Image Quality>
<Minimal Image Quality> £2t0|H{ & AF&5tH W EX I LG ZF0| HoHz(0f US W, O|0|X| SE I Z2j|g £ A0|Q] S = FY
T UASUCH =2 =2 Y S0 M Mot O[0|X|7t ERot 4= Ao, H2 =8 SE0A aoHE
Cial=g
HEXA LY =Z0f M20| Q= 2H40)| A, <Reduced> EI5FO 2 £210|EE &7|H 0|0|X| 20| Lo L|Ct.

ojojx|7t East 32k A

A~TEF 0] M| 4



HEXA LY =0f M20| Q= AL0|= PColP A|AHIO| <perception-free> A 1} AF 2t ©10] <Minimum Image Quality> Z2& & SX|

ZelgLc.

<Password> %t

<Password> &0l M= 22| Xt7F FX| Q| Ze[At 22 E YO0 EY 4= UELICH O] 2= @ 2IHE 0|2 & 2Z <OSD> GUIo| F&+2 0
ok
QBB EAMGE TYS AZOIK| R 4 YOO, BY U FOIshA YL 0[SO BLICH
* Password= l'HIOI?(I 22| QI H 0| A5 AL SI0] YH0|EY = /UELICH
© 2T PColP XM= Y= Bo7t 7|2 HO2 HIg g2 2D, O] <Password> g2 AHEZ = Y& LICE &= 25 & PColP
Management Console& ESH 2 31E 4= QI &Lt
12l 2-20: <Change Password>
Change Password
Old Password:
Mew Password:
Confirm New Passwaord:
| [_cancel |
* <Old Password>
2| X} 2 oF YX|SHOF LT
* <New Password>
<New Password> Z = = ¢l I I|0|AQt 2Z OSD GUI &% H=0| Alf 22|k} &= 7+ ElL|CL.
* <Confirm New Password>
<Confirm New Password> Z E &= 72t <New Password> Z =9 YX|8{OF BfL|Ct.
*  <Reset>
TH AT E BHSE SX| Y2 Z 2, <Reset> HHES F2T H2[X7t 32 KX 0 Response IEE QEE = Q& L|CH

Nsle B ot 2
Challenge 2 =2 22RH O 2 4 Y& LIck 22YHE

fo
[0

2 #4332, 5010 ELtH Response ZEE =2 2 L|Ct

Response A=E M2 YO, Lol A7t 8l ZXrE 2 MY O, 2[Rt 0{7[0f M 22 E Y 5= AFLICH

— =2
2= M2 S0l 2ot B0 = 28 SS MO AAMT LHES 2ot Al

12! 2-21: <Authorized Password Reset>

Contact your hardware vendor to reset a lost password,

Challenge:  xGJU MGZD  F|S4CD  [[LV3G  F2CTY  F{SNMJ

Response: || H H H

Cancel |

PColP A0 LSt L8 2 HAE £ QELCt X4 MEE H2{H Teradici @ AtO| E (http://www.teradici.com)&

HESBIAIA| Q.

LZEQ 0 2%



4-2  Natural Color

Natural Color 2+?

Z=3 Z 2| (Natural Color)= AHE X2} 7fEt
=1

2o o
ZEIHZ MY X E HSYULC

1%
¥
Iz
Ho
0R
=
B
ng
[O
hu

>

2

&g HEO T AEO| 7HSOtH MZE2 23 My =Fat M Et

L= Z2|= BAIOIEZ N& ELICH 2X[5t2{H Of2f ALO|EO|M L2 2= ’HOF 2X| 3tA| 2.

http://www.samsung.com/sec/consumer/learningresources/monitor/naturalcolorexpert/NC_download.html

AmEY0f HX| 42



4-3  MultiScreen

MultiScreenO|2F?

@ MultiScreen

StLtel ELIE ot S 02 42 Lo Ar8 " & ASLIEL

42X
1. #X 44X CDZ CD-ROM E20|=0j HoX|L.

2. MultiScreen A X| T2 12 S2lstL|C}.

B AZEQO MX|E Qs T 3tHO| EEX| 2 A2 CD-Rom Li2| MultiScreen Al IH 2 MX| 5}A| 2.

—

3. ZX| DHEAF SHHOJ LIEFLEE [CHE]E S ==L T
| S d

4. o|zo| Mx| ut

2 SO KA 2
8 - 2X=HNRYS o HE 82 SSH2E SHOH| s & USLICL
© PCAIAE BIAS AFLO| 2t MultiScreenz! e OFO| 20| LIEILIR| S == AFLICH

© 2 OfO|20| LIEtLIX] 35 [= F5 Key & 52| FHAIL.

AX|A| Heh AR 2 251" (MultiScreen)
MultiScreen| AX|= Jdef& 7tE, OIHEE, HEQ A 24 59| 22 &= = USLICL
Al AR 87 AFE
(OS]
*  Windows 2000
*  Windows XP Home Edition
*  Windows XP Professional
*  Windows Vista 32H|E
»  Windows 7 32H|E

B MultiScreen2 Windows 20000| A0 A| A2 S R & BHL|CL.
St=gof

« 32MBOJAto| B2 2|
« B0MB O|AtQ| BlE C|A3 &7t

A4
A 7O A [2EVMO1E]E MElstn, [Z2 12 RIYAMK|E & H St

2 20| MMultiScreeng MENS} S [FIYALH||CHEE S2I6HL|CL

AZE Y EX|



5 =HHZE

5-1 RLE XA ZITHSE7|

© AN HE 7SS S ME0| M2 ASotn A=X| 2ol & ASLIEL
© Y XNBZUPCIL ALY HZO| =|Of R2Lf, MF =t EHO[ 7T HEHZ U T BEAZF ZYAH2|H, T
= A TES 2Esib 2
1. PCeIHES 1M L.
2. M= A0l2E MEUHA Z2lgL/ch.
3. HEFE AME.
4. HZ0| 8YH2= XSt H, <7 0|5 A2 =0l> HAIX| 7} LIEFE L T

Of Wofl M|= =t FHO| 7H2t Ef 2 LIEFLEE, PC = AZMO| O] 0] RLEX] 2RI 2. HF2 0|&0] YlELIC,.

=X 52



52 1F M1 W =HQIA
B MHIAE QEoE| T Of2f AFES BIA 2ls) B Q. X7} S1Z 5K QTR ke AETR AHIA HE2 Sojshi|a.
S}20| ¢ LiotR. M0 o AH .
HeMo| H|2 @2 5lgiLte? HeHo| 0 HElE Gols) TR
S1210] <20] 217 Sel> BIAIRI7} LiEkLER? PCetol #0l% Q12 Helg 2ols) FH 2

0|20 HANO 2 AZE|0] QLB E SR BIAIX|7} LiEHt
Chl A B2| [ ISOURCE] HE S 521 §IEHSE ChA| ela
FHL.

SHHO|| <X|2SHA| f= R EYLICL> 2h= BAX[Z} LEEFLILER?

a2y 7tEOM Lte = A=

S 92 390 ByEL

= M7 ME2| Z|thol o = S | O3

ZCHe e W Fo=E A

S10H0| YAO| LIEFLIX| O] MYUEAISO| 1 ZHHo 2 7w | MH 7|50| S8} AU AEfYLICh
OlLta? OFA & 7|2 20| OFR HES F2 0 CHA| 313 0| A L|Ch
stHo| T ot st T o{ £ 8.

310 Mol <HUA>Tt <Et7|>2 EH 2AIK.
<MagicBright>5 <S ¥4 Yt XH>02 M| £3 YA wat 31 Bo| ¥t7|7t CHE 4= Y LICH
BLE HE0| SX}1X| oot
KEY =8 &2 7|50| MM |0 UK LLR? KEY 27 &3 7|52 simsthia
MA0| 0| 48R, SO R LIEHLLR.
SHEFK| 7} 2T F0|2 S8 2Ol AAE S7IK| MAoR B | PCoLo| #|02 A7 MEIS 2Hols) T4 2.
ot PCO| 1244 7}= 2 ChA S4B 71 YFH 8.
<M FpT) <SF>2 MHE| QR SHols] FA K.
Jejm Fte Tt M2 A HojQiLte T2 7he AL HYME HZS0] WA MHEH R
LXE7| 342 IX|7t B 7{LL HZO 2 K| 2K Q.
2= FIEL} EEJO|HE HIRLIR? [AUTOlHES =2 At& = 7|2 ¥ 2Ma

A HERLIR?

Jefm St ol SfAELE FOies

(EZEMSRCHE &)

J2Y 7tEIH MO 2 27 o lLte

e 7t AL 2

B+
12}
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M40 16H|E(16M)2 20k Liote. O T 7tES HRHE F M40 FEHH o .

o

o My 28O M2 0] ALtR? Windows XP : & 0] — 2 8L E|0F — C|AS|0] — 270 A
M-S AL 278N 8.

r

Windows ME/2000 : &|0{T — C|AZ 0| — AE0fA{ AALS Cf
Al 27E5HM 8.

Windows Vista : H|0{TH — @O 9 7§01 M& — J§OIMX — C|A
Zo0] B7H0IIM M2 CHA| 2ESHM 2.

Windows 7 : H|O{ Tt — 2 QF QI 7Ol MM — C|AZY|0| — S|AE

Pl

A - 03 MY > BUEOA NS CH| SN 2.
(KPS 2 ZBE) Windows ALS LTINS HESHHL.)
e FhE Tt REsh MRE|LR? Jeh FhEof Sako|wof S CHA| HEEHH 2.

BLIHE Aot ¥ ¥4 §lE BLE, PLUGKPLAY(VESA DDC) BLIE & RYSLICL 2t 277} LIEILLR.

HE =20l E EXIRULIR? EE2to|H EX[E HZ50] ME S2to|HE EX[5tM 8.
J2fE 7tE A8 FAM S F=0}0] PlugdPlay(VESADDC) 7|5 | E2to|H 2X|E F=o0] ME Z2t0[HE 2X[5H 2.

= 27 X 4oH=X] 25t K.

PC SLRIA| "t 8" 2|7} LIS.

PC £EAI H[ZZ0[ 3% O] 22T PC =M E M| ZoA[7] HHEHLICH

A2|7F ehLtetg. a2 AAMO| AAYENE T2 QISHALE 22S T EM Q.
A2|7} 42 EHotQ. =TS 2 EMR
SYS AUHZ S 227t ATHH AFE ARE 7EL AT ES)
O T2 IMO| SYS CHA| ZHSHA 8.
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Ol sff EM L

Tt Of A BHILER?

Fhtge 22 720 A B OF LT

Windows XP : H|O{Zt — 2 ¢F 8l |0 — C|AZ 0] - A™¥— T
S 2L HE MEs] Fot+=E HEst = 2L EH dHO|M Y E
= HEsHM 8.

Windows ME/2000 : | O &t
HE Mets] F=ot+=E HE
MNg.

Windows Vista : K| O{&ZH — 22k 5l 7§01 M7 — S|
0| 48> g 48 - BLUHE ME Fo=E HET =
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